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1 New Feature

The following new features have been added to the current version of Control Center:
 
1. Control Center can now display configuration information for USB 3.0 devices.
 
2. FX3 Firmware download feature has been added for the following modes:

    A. RAM
 
    B. I2C E2PROM

    C. SPI FLASH

3. CyScript feature for recording and playing  the FX3 and FX2 firmware download commands.
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2 ControlCenter

USB Control Center is used to communicate with Cypress USB devices that are served by CyUSB3.sys
device driver.

 
 

 USB Control Center Descriptor Info Tab Page 
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  USB Control Center Data Transfers Tab Page 
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 USB Control Center Device Class Selection Tab Page 
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2.1 Menu Bar

The Menu Bar provides shortcuts to the File, Device Programming and Help Functionalities.

1. File
2. Program
3. Help
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2.1.1 File

 

File -> Exit – used to exit the Control Center application.
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2.1.2 Program

 
Program menu provides option to program FX3 and FX2 devices.
 
The FX3 and FX2 menu items will be enabled/disabled based on the selected device type in the Device
Tree View.
 
Program FX3 Device

 
NOTE: Following firmware programming features are supported for FX3 boot devices only. The firmware
download operation will fail for non-boot loader devices.

Program ->FX3 -> RAM - This will allow user to download firmware (.img) to FX3 RAM.
 
Program ->FX3 -> I2C E2PROM - This will allow user to download firmware (.img) to FX3 I2C E2PROM.
 

Following are the steps to download firmware to I2C E2PROM.

Step 1: Click on I2C E2PROM menu item to download firmware.

           A. First, it will check for the Cypress Boot Loader device, if it is not present then it
will prompt message to user to reset the device. Please press reset button on the device.

           B. After detecting Cypress Boot Loader device, it will download the Boot
Programmer (.img) file, and wait for Boot Programmer device to enumerate on USB port.

               It will display below messages on the status bar.

             

Step 2: Install driver for Boot Programmer device for first time.
 

     If Boot Programmer device driver is not installed, then it will show the following
status.

             

             Please locate the CyUSB3.inf file from the  Cypress
USBSuite\driver\bin\OS\Platform) to install the driver for boot programmer device.
             NOTE:This operation will be timed out, so please reset the device after installing
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driver for boot programmer and please goto the step 1. 

Step 3: After detecting Boot Programmer device,it will prompt File Dialog box to the user.
User needs to select the Firmware (.img) file which needs to be flashed to I2C E2PROM.

       

 
Step 4: On successful firmware download, It will display "Programming of I2C E2PROM
Successful" message on the status bar.

Step 5: To enumerate device from I2C E2PROM, please reset your device or follow the
device specification to boot from the I2C E2PROM.

Program ->FX3 -> SPI FLASH - This will allow user to download firmware (.img) to FX3 SPI FLASH.
 

Following are the steps to download firmware to SPI FLASH.
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Step 1: Click on SPI FLASH menu item to download firmware.

           A. First, it will check for the Cypress Boot Loader device, if it is not present then it
will prompt message to user to reset the device. Please press reset button on the device.

           B. After detecting Cypress Boot Loader device, it will download the Boot
Programmer (.img) file, and wait for Boot Programmer device to enumerate on USB port.

               It will display below messages on the status bar.

             

Step 2: Install driver for Boot Programmer device for first time.
 

     If Boot Programmer device driver is not installed, then it will show the following
status.

             

             Please locate the CyUSB3.inf file from the  Cypress
USBSuite\driver\bin\OS\Platform) to install the driver for boot programmer device.
             NOTE:This operation will be timed out, so please reset the device after installing
driver for boot programmer and please goto the step 1. 

Step 3: After detecting Boot Programmer device,it will prompt File Dialog box to the user.
User needs to select the Firmware (.img) file which needs to be flashed to SPI FLASH.
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Step 4: On successful firmware download, It will display "Programming of SPI FLASH
Successful" message on the status bar.

Step 5: To enumerate device from SPI FLASH, please reset your device or follow the device
specification to boot from the SPI FLASH.

Program FX2 Device
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Program ->FX2 -> RAM – used to load the selected FX2’s RAM with firmware (.hex).
 
Program ->FX2 -> Small EEPROM – used to program 256-byte EEPROMs. When this is selected, the
user is prompted to select a (.iic) file to load into the EEPROM.
 
Program ->FX2 -> 64KB EEPROM – used to program 64-Kbyte EEPROMs. When this is selected, the
user is prompted to select a (.iic) file to load into the EEPROM.
 
Program ->FX2 -> Halt – performs a CPU Reset of the selected FX2.
 
Program ->FX2 -> Run – releases the CPU Reset of the selected FX2.
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2.1.3 Help

 
Help -> Help Topics - Opens the Control Center User guide.
 
Help -> About – Displays the Assembly version and Control Center version.
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2.2 Tool Bar

 

1. Script Actions.
2. URB Stat.
3. Pipe Actions.
4. Device Actions.
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2.2.1 Script Actions

Control Center provides a mechanism for creating and re-playing a sequence of data transactions.
 

 
Start Recording - Used to begin the script recording. Records the transactions done using Transfer Data
button
and Transfer File button. It also records firmware download transactions for FX2 and FX3 devices. 
 
Stop Recording - Used to stop the recording initiated by Start Recording button. Asks to save the script
file.
 
Load Script – Used to get the name and location of the script file to be played.
 
Play Script – Plays the loaded script using vendor commands onto the selected FX3/FX2 device.
NOTE:  For FX3 devices, the recorded firmware download commands will fail if device does not support
FX3 boot commands.
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2.2.2 URB Stat

Displays the state and status of last URB(USB Request block) to the client driver in the Status bar.
 

URB Status Displayed in Status Bar
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2.2.3 Pipe Actions

Abort Pipe – Used to cancel all outstanding IO requests for a pipe on the host.
 
Reset Pipe – Used to clear halt condition on the selected endpoint. 
 
Result displayed in Status bar.
 
 

Reset Pipe Button Clicked
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2.2.4 Device Actions

Reconnect Device – Reconnect device button power-cycles the USB port to which a specified device is
attached. Power-cycling a port causes the device to be removed and re-enumerated.
 
Reset Device – Reset device button resets the USB upstream port that is associated with the specified
USB device. After a successful reset, the bus driver re-selects the configuration and any alternative
interface settings that the device had before the reset occurred. All pipe handles, configuration handles
and interface handles remain valid.
 
 

Reconnect Button Clicked
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Reset Button Clicked
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2.3 Device Tree View

Displays Cypress USB devices connected and served by the CyUSB3.sys device drivers.
 

Device Tree View

 
Hot-plugging of USB devices is supported in Control Center. When a device that matches the specified
driver is plugged-in to the PC, it will automatically appear in the Device tree view. Similarly, unplugging a
device will also be updated in the device tree.
 
User can expand the devices in the device tree by clicking on the + sign to the left end of the device.
 
If the selected device is a FX2/FX3 device, user can view the device configurations which when expanded
show the control endpoint and interfaces. Each interface on expanding shows the Alternate Settings
which in turn contains endpoints. While selecting Alternate Setting in device tree, a set interface request
will be sent to the device. Similarly selecting an endpoint in any other Alternate Setting also sends a set
Interface request to the device.
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2.4 Tab Pages

1. Descriptor Info
2. Data Transfers
3. Device Class Selection
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2.4.1 Descriptor Info

Displays the descriptor information of the device selected in the device tree.
 

USB 3.0  BOS Descriptor
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2.4.2 Data Transfers

1. Transfer Data

2. PktMode
3. Transfer File

4. Clear Box

 

        Data Transfers Tab Page 
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2.4.2.1 Transfer Data

Data entered in “Text to send” field will be automatically converted to Hex byte and displayed in “Data to
send” field and vice versa. Value of “Bytes to Transfer” field is also automatically updated.
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2.4.2.1.1  Control Transfer

Steps for Control Transfer,
1. Select the control endpoint using the Device tree view.
2. Indicate whether the data is to be sent to the device (OUT) or read from the device (IN) using the

Direction Combo box.
3. Indicate the type of request (Standard or Class or Vendor) using the Req Type Combo box.
4. Indicate the target (Device or interface or endpoint or others) of transfer using Target Combo box.
5. Enter the byte representing the vendor request command code in the Req code field.
6. Enter the two-byte hexadecimal value for the vendor request’s wValue parameter in the wValue field.
7. Enter the two-byte hexadecimal value for the vendor request’s wIndex parameter in the wIndex field.
8. If the direction is OUT, fill the data to be sent in “Text to send” field or if the direction is IN, fill  the

“Bytes to Transfer” field with the size of data expected from device and initiate the transfer using
Transfer Data button.

 
 

 Control Transfer Fields 
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2.4.2.1.2  Non Control Transfer

Steps for Non-Control Transfer,
1. Select the endpoint using the device tree.
2. Since the endpoints are already configured to be IN or OUT clicking the 

Transfer Data button will receive specified number of bytes (if IN endpoint) or
sends the data filled in “Text to send” field (if OUT endpoint).

 
 

Bulk Out Transfer

 



ControlCenter 29

© 2018 Cypress Semiconductor

Bulk In Transfer
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2.4.2.2 PktMode

This feature enables the application to split the transferred data into packets whose size is  defined by
the MaxPacketSize of the request on Bulk and Interrupt endpoint. 

Example: User request length is 2048 bytes on bulk OUT endpoint and the MaxPacketsize of endpoint
is 1024 bytes.

If PktMode option is enabled then application will send data in  2 request each request length will be of
MaxPacketSize.

If PktMode option is disabled then application will send data in 1 request only.
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2.4.2.3 Transfer File

This button is visible only if the selected node is a device served by “CyUSB3.sys”.
 
If the selected node is a device served by CyUSB3.sys,
Steps :
1. Select an OUT endpoint using the device tree.
2. Click the "Transfer File-OUT" button. Select the file to send(here it  will  send the number of bytes

available in the file), contents will be displayed in the output box.
3. Select the IN endpoint.
4.Click the "Transfer File-IN" button.
5. Save the file.
 
 

Bulk Out File Transfer
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Bulk In File Transfer
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2.4.2.4 Clear Box

Clear Box clears the Output box and Status bar below.
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2.4.3 Device Class Selection

 
The Control Center provides interface for Cypress Vendor specific device only.
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3 Features Not Supported

Following functionalities are not supported by the current version of Control Center.
 
1. Mass Storage and HID class devices configurations are not supported.
 
2. Device Select Monitor and Load Monitor functionalities are not supported.
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